Abstract: EndNote is a reference management application that academic writers can use to streamline and simplify the research and writing process. You can export citation information to EndNote from online searches, attach PDF files to the citations in your library, then save time by creating an automatic bibliography in Word from your EndNote library.

Specific topics include:

- Downloading EndNote and creating your EndNote library
- Adding references to the library
- Organizing references in the library
- Attaching files to EndNote references
- Backing up your library
- Using Cite-While-You-Write in Word to automatically create and update your bibliography
# Table of Contents

Installing EndNote ........................................................................................................... 3

Working with the EndNote Library ...................................................................................... 6
   Key Features (see image above) ....................................................................................... 7
   Selecting the Output Style .............................................................................................. 7
   Exporting Citations to your EndNote Library: The Basics ............................................. 8
      Getting Started with Google Scholar ........................................................................... 8
      Including PDFs and Other Files in your Library ......................................................... 10
      Frequently Encountered Pop-Ups (and what to do about them) .................................. 11
   Other Common Sources for Gathering Citations ............................................................ 12
      ProQuest Databases .................................................................................................... 12
      EbscoHost Databases .................................................................................................. 13
      KU Libraries’ Home Page Search (PRIMO) ................................................................. 14
      Using ISBN to Export Book Citations from WorldCat ................................................ 16
      Collecting Citation Information from Web Sites ......................................................... 18
      Adding a Reference Manually ...................................................................................... 19
   Working with your References in the EndNote Library ................................................... 20
      Toggling the Sort Order ............................................................................................... 20
      Searching for References ............................................................................................ 20
      Viewing and Editing References ................................................................................ 21
      Creating Groups of References .................................................................................. 23
      Deleting a Reference ................................................................................................... 24
   Backing Up and Sharing your Library ............................................................................. 24
      Compressing the EndNote Library ............................................................................. 24
      Storage and Collaboration ........................................................................................... 24

Cite While You Write: Using EndNote in Word ................................................................ 25
   Working with Citations .................................................................................................. 25
      Inserting In-Text (Author,Date) Citations ..................................................................... 25
      Inserting In-Text Citations as Footnotes ..................................................................... 26
      Deleting Citations ....................................................................................................... 27
      Editing Citations ........................................................................................................ 27
   Turning off Instant Formatting ....................................................................................... 29
   Why is the Bibliography Single-Spaced? Finalizing the Bibliography Layout .................. 29
   The Final Copy .............................................................................................................. 30

Other Useful EndNote Functions ....................................................................................... 31
   Importing Previously Stored PDF Documents to EndNote ........................................... 31
   Using the Find Full Text feature .................................................................................. 32
      First Time Setup for Find Full Text ........................................................................... 32
      Using Find Full Text .................................................................................................. 33
   Setting Automatic Naming for PDFs .......................................................................... 33
   Exporting Bibliographies from EndNote ....................................................................... 34

For More Information ....................................................................................................... 35
EndNote is a reference management application that academic writers can use to streamline and simplify the research and writing process. This handout is designed to get you started using EndNote. It contains step-by-step instructions on how to perform basic tasks. The KU Libraries offer several additional how-to guides for more advanced topics, which are available from our online LibGuide at http://guides.lib.ku.edu/citation/EndNote. For more information, see the full list of advanced topics at the end of this document.

Installing EndNote

Note:
It is important to note that EndNote works best with Firefox. Using EndNote with Google Chrome or Safari will not produce reliable results.

1. From the website technology.ku.edu/software/endnote, click Download at KU’s Web Store. You will need to have administrator access to your computer to install EndNote.

2. You may be prompted to log in. Use the Single Sign-On option.

3. In the next screen, select EndNote X7.

4. Choose your platform (Mac) and click Add to Cart.

5. In the next screen, click Check Out and then access your e-mail to continue the download process. From here, the download process will continue in two phases. First, you will download and install the Secure Download Manager file, then you can download and install the secure download file for your EndNote order.
6. You will see the screen pictured below. To begin, click **Download SDM**.

![](image1)

7. In the Opening SDM.pkg box, click **Save File**.

8. Next, use Finder to find the SDM.pkg file in your Downloads folder (or, if you stored it in an alternative location, you should find it there) and double-click.

9. You will be guided through a number of installation screens and must agree to the licensing terms. Also, the fourth screen will prompt you to “Install for me only.” The **Continue** button here will not be active until you click on “Install for me only.”

![](image2)

10. Now return to the Download Instructions screen, which should still be open in your web browser, and click **Download.SDX**.
11. In the Opening xxxxx.sdxx pop-up box, make sure the Open with drop-down is set to SecureDownloadManager (default) and then click OK.

12. Next, click Start Download in the Secure Download Manager pop-up box.

Note that you will need to close all Microsoft applications, including Word and Outlook, in order to install EndNote.

13. When the download is finished, click Launch.

14. Your Finder will automatically open to the Downloads folder. From here, find and open the EndNote X7 for Mac (KU) folder, then double-click the EndNoteX7SiteInstaller_KU.dmg file to begin the installation.

15. In the next box, drag the EndNoteX7 icon to the right, following the red arrow, and drop it in the Applications folder.

The installer will guide you through another set of screens to complete the installation process.
Working with the EndNote Library

If EndNote does not open automatically for you when the installation completes, or to access it again later, open it from your Applications folder in Finder.

1. To create a new EndNote library, open EndNote and click File then New.

2. In the Save As box, enter the name for your new library.

3. In the Where box, indicate where you want to save your library and its data folder.

4. Because you will need to have the folders together to move or copy them to other locations, selecting Save as Package is recommended.

5. Click the Save button.

6. A new, blank library will be displayed in the main EndNote window.

Described below according to the green numbers in the above image, some key features to know about this library as you begin include:
Key Features (see image above)

1. The My Library pane shows the file system for your library. The All References folder is your library’s “home base”—a master file where all your references are stored. Below this, you can create groups to categorize your references (more on this later.)

2. The middle pane shows a listing of the references in your library.

3. In the References pane, you can see and change, at a glance, the citation information of any reference.

4. The style selection box allows you to designate the citation style for your library. When you first open EndNote, it will be set to a citation style called “Annotated.”

5. The Preview box provides a preview of the citation as it will appear in your bibliography (based on your selected citation style—see item 4).

6. Attached PDFs can be viewed in the pane on the far right.

Selecting the Output Style

It is important to set the output style to the one that you plan to use or that is required by your discipline, department or journal, as it will determine the appearance of in-text and bibliographic citations as well as EndNote previews. EndNote will remember your favorite styles and keep them in the drop-down list, but when you first begin, you will need to add your styles.

1. To change the style, click the drop-down arrow in the style box (labeled #4 above) and look for your style in the list that appears. If you do not see it, click Select Another Style… from the top of the list.

2. From the Choose A Style pop-up box, select your style from the list then click Choose.

There are nearly 500 styles to choose from and many more available online at www.EndNote.com.

New styles are added regularly to those available for download from EndNote.com, and styles for many journal articles are also available. Step-by-step installation instructions are included on the download page as well.

You can also edit and customize styles to fit your own needs. Visit the library’s EndNote website for detailed instructions: http://guides.lib.ku.edu/citation/EndNote
**Exporting Citations to your EndNote Library: The Basics**

For all databases at KU that will export to EndNote, step-by-step export instructions are available at: [http://www.lib.ku.edu/endnote-citing-instructions](http://www.lib.ku.edu/endnote-citing-instructions). Use the search bar to find the database you need quickly.

<table>
<thead>
<tr>
<th>Title</th>
<th>Vendor</th>
<th>EndNote Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>AATA Abstracts of International Conservation Literature</td>
<td>AATA Abstracts of International Conservation Literature</td>
<td>EndNote Instructions</td>
</tr>
<tr>
<td>ABIINFORM</td>
<td>ProQuest</td>
<td>EndNote Instructions</td>
</tr>
</tbody>
</table>

**Getting Started with Google Scholar**

Google Scholar is a popular search engine for academic research. Using Google Scholar while logged into the library will help expand the range of your search and will make more electronic texts available to you. You will also need to be logged in to export citations to EndNote.

**Initial Setup**

1. First, from the KU Libraries home page ([www.lib.ku.edu](http://www.lib.ku.edu)) click Articles and Databases (under Find) then click **G** under **Databases A-Z** to then scroll through the Gs to locate and open Google Scholar.
2. Before you begin your search, you will need to set up Google Scholar to export to EndNote. In the upper right corner of the Google Scholar home screen, click Settings.

3. Under Bibliography manager in the Scholar Settings menu, click Show links to import citations into and from the drop-down menu, select EndNote, then click Save.

Google Scholar will save these settings for your current computer and internet browser. Now conduct your Google Scholar search as usual. Although some databases allow simultaneous export of multiple references, in Google Scholar, references must be exported one at a time.

To Export

1. First find the article you want, then click Import into EndNote.

2. EndNote will open automatically and the reference will appear in the Imported References folder. It has also been added to the All References group.

Note: If you instead receive a pop-up box asking the question: “What should Firefox do with this file?,” click Open with and then Choose. This will route you out to your Finder. From here select EndNote X7 and then again, from the submenu, select EndNote X7. Back in the pop-up window, click “Do this
automatically for files like this from now on” and then click OK. You may have to do this several times as you download citations.

Including PDFs and Other Files in your Library

The next step is to return to the databases to collect and attach the PDF files that did not come through using the Find Full Text command. For this, it is a good idea to keep your library searches open in Firefox until you are sure you have collected and attached all the necessary PDF files.

1. Click back over to your online databases screen (in this case, Google Scholar). In the example below, clicking either PDF from jstor.org or Get at KU will provide a re-direct to the article.

![PDF from jstor.org]

2. Save the article to your desktop or any other location that is easily accessible. (If you do not see an option to save, click Command+Shift+S to prompt it.)

3. Back in your EndNote library, click once on the reference to highlight it then right-click to open additional options.

4. From the menu, click File Attachments, then move across to Attach File.

![File Attachments]

5. Navigate through your file system to find the file you need, then click Open.

6. When finished, click away from the listing. You will be prompted to save and a paperclip will appear to indicate that the file has been successfully attached.
**Frequently Encountered Pop-Ups (and what to do about them)**

From some KU databases, the *Import to Citation Manager* box will pop up as a last step in completing the export. For this box, simply accept the UTF-8 encoding by pressing **OK**.

Next, you may also encounter a pop-up box asking with what program the export should open (Opening Primo_RIS_Export.ris). In this box, check **Open with** then from the drop-down arrow, choose EndNote X7. In some cases, clicking the drop-down arrow will open your Finder but here again, just keep choosing **EndNote** and clicking **OK** until the process completes.

---

**Open or Save?**

You may frequently encounter pop-ups asking whether you want to “Open with” or “Save.” To help keep things running smoothly:

Choose **OPEN** if you’re exporting citations.
Choose **SAVE** if you’re downloading a PDF.
Other Common Sources for Gathering Citations

ProQuest Databases
1. To export multiple citations from a ProQuest database, click the boxes to the left of the title.

2. Next, from the same screen, click the menu item labeled Save.

3. From the drop-down list, select RIS (works with EndNote, Citavi, etc.).

4. In the pop-up Export/Save box, click Continue. (If you do not see the green Continue button, look for a pull-down scroll bar on the right-hand side of the box.)
**EbscoHost Databases**

1. Conduct your search then click the **Add to folder** icon for citations you plan to export.

2. Next, click **Folder** from the top of the screen.

3. In the Folder screen, click on the boxes next to the articles to be exported or click the **Select/deselect all** box from the top, as indicated below.

4. Click **Export**.

5. In the final screen, check **Direct Export in RIS Format** and then click **Save**.
**KU Libraries’ Home Page Search (PRIMO)**

1. Begin by typing in your search query and clicking **Search**. Type exact titles to pull up a specific book or other resource (or use the Advanced Search options).

2. In the results screen, use the options on the left to narrow your search. This search has been narrowed to include only books.

3. Find the book (or other item) that you need.

4. Click on **Details** in the horizontal list of options along the bottom of the entry.

5. Hover over the **Email/Print/Export** option to the right.

6. From the drop-down list, click **Export RIS (Endnote, Zotero)**. The export should continue automatically from here.
You can also select multiple items from the KU Library search results. To do this,

1. Conduct your search.

2. When you see results you’d like to keep, check the box to the left of the title, then click e-Shelf from the top of the page.

3. Your items will appear in a shopping cart format. Select the citations you want to export or click the top box to select all.

4. On the right, a drop-down box shows export options, choose Push to RIS (EndNote, Zotero) from this box and click Go. (Do not choose EndNote Web unless you have an EndNote Web account.)
Using ISBN to Export Book Citations from WorldCat

You probably have several physical books on your bookshelf or desk that you would like to include in your EndNote library or cite in your papers. The WorldCat database makes it easy to export exactly the right citation information for these.

1. From the KU Libraries home page, click on the W under Databases A to Z then select WorldCat from the list.

2. Find the ISBN number for your book (usually it is located near the copyright information) and type it into the ISBN box in WorldCat. Exclude hyphens.

3. Click Search.

4. Check the one you want from the list and then click Export.
5. In the next screen, check **Marked records from this search** for the Export: option and **EndNote** for the Export To: option, then click Export.

![Direct Export Records](image)

6. Your web browser may need you to confirm EndNote as the application.

![Opening DirectExport](image)

7. When asked to choose and import filter, select **WorldCat (OCLC)** and then click Choose. (Do not choose WorldCat Diss.) The export should complete automatically from here.

![Choose An Import Filter](image)
Collecting Citation Information from Web Sites

You can download website citations into EndNote Web or, if you prefer, send them directly to your desktop version of EndNote instead, but you first need to set up an EndNote Web account and add the Capture Reference bookmarklet. Here’s how:

To begin, set up an account at www.myendnoteweb.com if you haven’t already.

From the home screen of your EndNote Web account, hover over the Options tab then click Download Installers.

Follow the on-screen instructions. Begin by attempting to drag the Capture Reference item to your bookmarks toolbar. As the instructions specify, “in some browsers, you may need to right-click and select “Add to Favorites” or “Bookmark This Link.” (In Firefox, if you cannot see your bookmarks toolbar, try clicking View then Toolbars then Bookmarks Toolbar.)

Next, visit a website from which you plan to capture citation information.

Open the article or page you for which you plan to capture citation information, then click the Capture Reference bookmark in your toolbar.

The Capture New Reference pop-up box will open:

- At the top of this box, choose whether you plan to send this citation to EndNote Web or EndNote.
- Check the fields in the box for completeness and accuracy, according to your bibliographic needs. The auto-fill feature here works better in some sites than others, so you may have to add some information by hand.

When your citation is complete, click the Save to button to finish the process.
**Adding a Reference Manually**

If you have resources that need to be included in your library but are not available for download (such as interview transcripts, datasets and unpublished manuscripts), you can add them to EndNote manually using the New Reference function.

If you have resources that need to be included in your library but are not available for download (such as interview transcripts, datasets and unpublished manuscripts), you can add them to EndNote manually using the New Reference function.

To enter a new reference into an EndNote Library:

1. Click on the **New Reference** icon (circled in red in the image on the right). A blank **New Reference** window will open. (In some older versions of EndNote, you may need to click References from the top menu, then choose New Reference.)

2. From the **Reference Type** drop-down menu, select the appropriate reference type. (There are several options—some are shown on the right.) Different references types have different available fields, so choose the type first, before you enter any information.

3. Type or paste the information for the reference into the appropriate fields and attach files. When you’re finished entering the reference information, click **File**, then **Save** and close out of the smaller window to return to EndNote’s main screen.

**Note:**
Add author information last name, comma, first name, with a hard enter between each name. For institutional authors, such as the Department of Education, place a comma at the end of the name to keep EndNote from formatting the name as a person’s name (for example: United States Census Bureau).
**Working with your References in the EndNote Library**

**Toggling the Sort Order**
From the middle pane of EndNote, references can be sorted according to the fields included in the overhead bar (highlighted in green below).

- Click on any of the fields to sort by that field and again to reverse the order in which the references are listed in the EndNote library.
- References are arranged in alphabetical order by author as a default for EndNote. Sorting by **Last Updated**, however, is particularly helpful when you want to see your most recent additions to the library.
- You can also drag the headings to rearrange the order in which the columns appear. Here, the **Last Updated** column has been dragged left from its default position.
- Right-click on any column header to add or delete columns.

<table>
<thead>
<tr>
<th>Author</th>
<th>Year</th>
<th>Title</th>
<th>Last Updated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rabin, Matthew</td>
<td>1993</td>
<td>Incorporating fairness into game theory and eca...</td>
<td>7/25/13</td>
</tr>
<tr>
<td>Moss, C. F.; Sinha, S. R.</td>
<td>2003</td>
<td>Neurobiology of echolocation in bats</td>
<td>7/25/13</td>
</tr>
<tr>
<td>Doe, Jane; University of Kansas Press, 2013</td>
<td>EndNote How-to Guide</td>
<td></td>
<td>7/19/13</td>
</tr>
</tbody>
</table>

**Searching for References**
You can search for references from within the library using either the smaller **Search Library** box at the top right or from the **Advanced Search** boxes. (If you don’t see the Advanced Search box, click the Layout box just to the left of the simple search box and choose **Show Search**.) The screenshot below shows some of the tools and functions of the Advanced Search.

1. Hover here and pull down to increase the height of the Advanced Search window.
2. You can add or reduce parameters by clicking the plus and minus icons to the right.
3. Use the **Search Whole Library** function to add or remove listings from view.
**Viewing and Editing References**

The references pane on the right gives a preview of any selected reference (highlighted in green below). Click in any of the fields to edit.

To open the full reference, double click on it from the list in the middle pane.

- Scrolling downward through the full reference reveals fields such as Abstract, Notes, File Attachments and Research Notes.
- You can use the Research Notes field to add up to 22 pages worth of your own text.
- You can attach up to 45 additional files. (Note that using the PDF file icon under the File Attachments heading will open the file in your default PDF viewer.)
You can also change the layout options to show a larger view of the PDF file. This approach will open the PDF using EndNote tools, which include highlighter and sticky-note functions. To open the PDF using EndNote tools:

1. Click the layout options drop-down menu.
2. Choose either Right-PDF or Bottom-PDF.
3. Click the Annotations Toolbar icon.
4. From the Annotations Toolbar, click the highlighter icon or other editing function.

Creating Groups of References
Creating Groups of References
Groups act as the file system for your references, allowing you to create sub-collections within your larger library. Labeled in the screenshot on the right:

1. A **Group** is simply a file folder holding a collection of references you’ve chosen. These references are also stored in the All References folder.
2. A **Group Set** gives a title to a collection of groups and allows you to expand and collapse your filing system to suit your needs.
3. **Smart Groups** are groups that populate automatically based on parameters you choose.

Groups
1. From the drop-down **Groups** menu, click **Create Group**.
2. Type a name for your new group in the box.
3. You can drag and drop group folders as needed.
4. To add references to a group, right-click on the reference (use shift+click and/or control+click to select multiple references) then hover over **Add References to** choose the correct group from the pop-up list.
5. To remove items from a group, click once on the item (or use Command+Click to highlight multiple items), then right-click and select **Remove References from Group**.
6. To delete a group, simply click on it once to select, then right-click and choose **Delete Group**.

Group Sets
1. From the drop-down **Groups** menu, click **Create Group Set**.
2. Type a name for your group set in the box.
3. You can drag and drop group sets as needed.
4. Use the right-pointing and down-pointing arrows to expand and collapse group sets. Right-click on the arrow to delete a group set.

Smart Groups
1. Choose **Create Smart Group** from the **Groups** drop-down menu.
2. Fill in the boxes to define the parameters of your group then click **Create**. You can use any of the fields to set up parameters. Use the plus and minus icons to add or remove parameters. You may need to tweak your parameters to ensure that your smart group is capturing the references you want.
**Deleting a Reference**

To delete a reference from the entire library, open the All References folder, highlight the reference then press Delete.

**Backing Up and Sharing your Library**

Because EndNote stores your library as two files—a .enl library file which contains your citations and a .data file which contains your PDFs—it is important to “compress” these before attempting to move or copy the library.

**Compressing the EndNote Library**

1. From the File menu, click Compressed Library (.enlx)...

2. The defaults presented in the Compressed Library pop-up box will likely be the ones you will want to use. Make any adjustments and then click OK.

3. In the Save Compressed Library choose a location and name for your file, then click Save.

4. From that location, you can now move or copy the file with the .enlx extension.

5. When you are ready to open the file, simply double-click on it. You can open it from any other computer that has EndNote installed, including PC-based systems.

**Storage and Collaboration**

Saving to a flash drive, Dropbox or Hawk Drive, or synchronizing your EndNote desktop library with an online EndNote Web library are among the options for backing up and sharing your library. Visit our website for more information and step-by-step how-to guides for these options: http://guides.lib.ku.edu/citation/EndNote
Cite While You Write: Using EndNote in Word

One very useful feature of EndNote is **Cite While You Write** (CWYW), which enables you to insert formatted citations and build a bibliography within your document at the click of a button. Once EndNote is installed, the CWYW tools appear in the Tools menu of your Word document and are also available as a toolbar.

If you don’t see the toolbar, click **View**, then **Toolbars**, then **EndNote X7**.

**Working with Citations**

To use CWYW tools, you must open both your Word document and your EndNote library. Commonly used citation styles may either use an in-text (Author,Date) format (APA and MLA styles, for example) or may instead utilize footnotes (like Chicago 16th A). Instructions for both are included below. For any citation style, however, begin by ensuring that it appears in the Style box of your EndNote toolbar in Word. Use the drop-down arrow here to change it if necessary.

**Inserting In-Text (Author,Date) Citations**

1. Position your cursor within the document where you intend to place the in-text citation(s).

   ![I need to insert a citation here](image)

2. Click on the magnifying glass icon near the left side of the EndNote toolbar.

3. From the **EndNote X7 Find & Insert My References** pop-up box, type any search term in the upper search bar and press **Return**. — Note: You can use **command+click** or **shift+click** to select multiple citations to insert.

4. Choose your citation from the search results and click **Insert**. Note the drop-down arrow with options to exclude the author or year.
5. EndNote will return you to Word and insert the citations you have selected. Note at the bottom of your document that EndNote begins your bibliography as well. EndNote will update this bibliography as you make changes to your document.

I need to insert a citation here (Holland, Kirschvink, Doak, & Wikelski, 2008)

Works Cited

Alternatively, you can also add citations by clicking on the EndNote icon in your Mac toolbar or Tools then EndNote X7 then Go to EndNote from the Word menu ribbon at the top of the screen. This will simply pop your EndNote library onto your screen and here, you can have a certain group or section of your library open for use. Click the citation (or Control+Click for multiple citations) and then click the Insert Citation button to finish. This approach is especially useful if you want to be able to see your EndNote library while adding citations. If you can work with two screens instead of one, you can have your EndNote library open in the other screen, then you simply need to click the citation you want then click the Insert Citation icon to add it.

Inserting In-Text Citations as Footnotes
To create these citations, you must first create the footnote using the tools provided within Word. Once you have created a note in Word, you can cite references in that note just like you cite them in the body of the document.

1. Place your cursor at the location in the document where you would like to insert the superscript number for the footnote then, from the Document Elements tab in the Word menu, click Footnote.
2. Word will place the superscript number for you and will drop your cursor to the footnote area at the bottom of the page.
Note: This approach pertains mostly to Chicago 16th Footnote style. In many footnoted styles, such as that of the American Chemical Society, EndNote will automatically place the superscript for you when you click Insert Citation. For these styles, skip instructions 1 and 2 above and simply insert your in-text citations as normal.

4. From here, progress as usual by clicking the magnifying glass icon on the EndNote toolbar.

5. From the EndNote X7 Find & Insert My References pop-up box, type any search term in the upper search bar and press Return. Note: You can use Command + Click or Shift + Click to select multiple citations.

6. Choose your citation from the search results and click Insert. Note the drop-down arrow with options to exclude the author or year.

7. EndNote will return you to Word and insert the citations you have selected. Note at the bottom of your document that EndNote begins your bibliography as well. EndNote will update this bibliography as you make changes to your document.

**Deleting Citations**

To delete one in-text citation, simply highlight it in your document and click Delete. To delete or change multiple in-text citations, see below.

**Editing Citations**

To edit citations (for example, to add page numbers, remove the author’s name or include prefacing comments like “See also”),

1. Right-click on the in-text citation and scroll down to Edit Citations.

2. From here, you can quickly exclude the author or year (or both) from your citation.

3. To make other changes, for example, to add page numbers, click on More. This will open the EndNote Edit and Manage Citations box.
The Edit & Manage Citations box will open to the location of the selected reference and houses several options including:

1. In the Edit Citation tab of the lower box, add page numbers or a prefix (such as “See also”) or suffix. To add page numbers for multiple citations, simply fill in the page number in the Pages box, then click the next reference in the upper window and repeat.
2. Click the upper gear icon then Edit Library Reference to make changes such as spelling corrections. These changes will be updated throughout your document and the EndNote library.
3. Click the upper gear icon then Remove Citation to remove a citation.
4. Click the upper gear icon then Insert Citation to add another reference to a multiple intext citation.
5. Click the Reference tab for a quick view of the citation information.

When you are finished making changes, click OK. Library references corrected in EndNote will be updated in Word the next time the document refreshes or you can manually activate the refresh process by clicking Update Citations and Bibliography from the EndNote X7 tab in Word.
Turning off Instant Formatting

If the constant updating is causing your system to hang, lock up, or is just too slow, you can turn it off.

1. From the EndNote toolbar, click the Bibliography drop-down menu and then select Turn Instant Formatting Off.

2. Continue to use EndNote as usual. Your citations will now appear with tags, as in the example below. EndNote will not build your bibliography while Instant Formatting is turned off.

Example: I need to cite this sentence {Brunner, 1994 #112}.

3. To add page numbers while Instant Formatting is turned off, place your cursor just to the left of the closing bracket and type the @ symbol followed by the pages you wish to cite.

Example: I need to cite this sentence {Brunner, 1994 #112@227-229}.

4. EndNote will add the bibliography and correctly re-format your in-text citations when you turn Instant Formatting back on. To turn it back on, simply repeat the process above, toggle to Turn Instant Formatting On. You can also update manually while Instant Formatting is turned off by clicking Update Citations and Bibliography (highlighted in green above). Before doing either, though, be sure to save.

Why is the Bibliography Single-Spaced? Finalizing the Bibliography Layout

Cite While You Write always creates the initial bibliography at the end of the Word document as you go. To make changes to your bibliography, click the Bibliography drop-down from the in your EndNote toolbar.

This will open the Configure Bibliography box. Clicking on the Layout tab will enable you to make changes to the font, font size, bibliography title and line spacing, among others, that will be retained each time EndNote updates your document.
The Final Copy

Before you submit the final version of your paper, you will need to disconnect the paper from your EndNote library. This will convert your EndNote-enabled citations to simple Word formatting where your citations will function according to the same rules that govern the rest of your document.

1. Save your final draft. At the end of this process, you will have two papers, one with EndNote formatted citations and one with plain text citations. It may be useful to keep the same title for both documents but to add the words “EndNote” and “Plaintext” accordingly.

2. Next, from the Tools drop-down in your EndNote toolbar, click on Convert to Plain Text.

3. EndNote will give you a warning message that it is about to create a separate copy of your paper. Be sure that you have already saved your document, then click OK.

4. In the new version, EndNote’s gray shading will no longer appear when clicking on EndNote items (indicating that it is now fully a Word document) and the unsaved name “Document1” appears at the top. Save the new document.

What about last minute additions after you have removed your field codes?

When you find that you have last minute edits to make after you have converted to plain text you can make those edits in the EndNote-enabled draft. Once you make those edits, save and convert to plain text again in the same way.

WARNING: On Mac systems, this process will strip all the field codes from your document, so it is important to plan ahead a little if you want to use other Word formatting features such as bulleted lists. To avoid having to add these features a second time, plan to complete the first version of your document without them, then use EndNote’s “Convert to Plain Text” function, and then go back through the document and add the special formatting.
Other Useful EndNote Functions

Importing Previously Stored PDF Documents to EndNote

You can import single PDF files or folders of PDF files and, for any files that contain DOI information, EndNote can scan the internet and attach the citation information you will need for your bibliography. It then creates a full reference including the citation information with the PDF file attached. Here’s how:

1. It may be easiest to begin by collecting all the PDFs into one folder.

2. Open your EndNote library and click on File.

3. From the drop-down menu, select Import.
   - On Mac systems, this will open your Finder.
   - On PC systems, click on either File or Folder, then, in the pop-up Import File box that follows, click Choose.

4. Navigate to the file or folder you wish to include and click on it.

5. In the Import Option drop-down box, choose PDF.

6. The Duplicates drop-down will give you options regarding duplicate files. It is recommended that you choose Import All [then use EndNote’s Find Duplicates function later (available from the References tab) to compare duplicates and be sure you’re keeping the ones you want.]

7. Click Import.

When the process is complete, your library reference will show the citation information, the attached PDF file and the paperclip icon. Imported files will appear in both the Imported References and the All References folders.
Using the Find Full Text feature

EndNote’s Find Full Text feature will search for PDF files for designated references in your library and, if it finds them, will automatically attach them to the reference. If you have exported a large batch of articles, this is a good option to try before manually downloading and attaching each article individually. Many times, EndNote will be able to find half or more of the articles for you.

First Time Setup for Find Full Text

Find Full Text will have to be configured with KU Libraries authentication information before you can use it. The image below shows the correct settings.

1. Click EndNoteX7 from the upper menu then click Preferences and click on Find Full Text in the EndNote Preferences box.

2. In the pop-up box, apply the settings as shown in the image below. This includes:
   • Ensure that all check-boxes are checked.
   • For the OpenURL Path box type: http://vv6tt6sy5c.search.serialssolutions.com
   • For the Authenticate with URL box type: http://www2.lib.ku.edu:2048/login?url= At the bottom of the box, click Save.
Using Find Full Text
Once the setup is complete, you are ready to have EndNote search for articles to attach.

1. In your library, use shift+click or command+click to highlight the references to include in the full text search.

2. From the top menu, click References then Find Full Text then scroll across to again click Find Full Text.

3. You may be prompted to log in to the library.

4. Click OK to the copyright warning screen. Your search should continue automatically from there.

The Find Full Text group set in your My Library pane will show an ongoing progress indicator as EndNote searches for and attaches the files it finds. When it attaches a PDF to one of the references in your library, EndNote adds a paperclip icon to the left of the listing.

Setting Automatic Naming for PDFs

PDF files often download with unusual names. In the past, it has been necessary to re-name the file when downloading it. With EndNote X7, however, you can set up automatic naming preferences to have EndNote re-name the file for you as it brings it into your EndNote library.

To set up this function:

1. From the EndNote library, click EndNoteX7 then scroll down and select Preferences.

2. In the EndNote Preferences box, click PDF Handling then choose your preference from the PDF Auto Renaming Options on the right. When you are finished,
**Exporting Bibliographies from EndNote**

EndNote can make a formatted bibliography directly from references selected from your library. This is handy if you just want to send a list of your sources to someone else or to make a printout of all or selected library contents.

1. From your full library or desired group, highlight the references that are to be included in the bibliography or click command+A to select all.

2. Next, click **File** from the top menu then **Export**.

3. In the **Export file name** box,
   1) Choose a location for your bibliography.
   2) Create a name for your bibliography in the **Save As** box.
   3) Choose to save the file as text or rich text (recommended) format in the **Save file as type** box.
   4) Set the **Output style** that will determine the appearance of your bibliography.
   5) Make sure the **Export Selected References** box is checked.
   6) Click **Save**. You can open the file from the location in which it was saved (Desktop in this example).
For More Information

The libraries offer several tip sheets and how-to guides for additional EndNote topics. These can be accessed online at http://guides.lib.ku.edu/citation/EndNote. Topics include:

EndNote:

- Editing your output style
- Getting new output styles
- Working with journal abbreviations
- Modifying a reference type
- Copying and re-using references
- Getting and installing EndNote filters
- Importing to EndNote using text tags
- Using the Traveling Library and other features for collaboration
- Using Hawk Drive and Dropbox with EndNote
- Using EndNote with SumNotes
- Converting citations from Excel to EndNote
- Using EndNote Web
- Sharing and collaborating with EndNote

KU Information Services

Information Services provides consulting and Q&A help in a variety of ways: By phone at 785/864-8080 or by e-mail at questions@ku.edu.

To learn more about or register for workshops, receive automatic announcements of upcoming workshops, and track workshops you’ve registered for and have attended, visit the http://apps.ku.edu/~infotrain/calendar.php.

For further workshop related questions, please email training@ku.edu.

EndNote.com

www.endnote.com is the place to find updated versions of connection files, import filters, output styles, and the EndNote program itself. Tip sheets, a technical support database, and utility programs for repairing damaged EndNote Libraries and converting from other bibliography management tools to EndNote are also available from the Support & Services area of this site.

For information specific to EndNote Web, visit www.endnote.com/support/faqs.